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3. FESUARG ARG R SO I T BRI B TXT VAT IESCAHT T

4. HESTREI A 2 S A 2 BT AR

5. FET FRSCA X I8 o B0 VF T E BV T GE 41 06 A B I ASORE I ST A 2

FESCAR DR J7 B 26T 2, VR A SR I SO vF T E A VR AT IE AL 5

A 5T A

IR AESE T A

Schaeffler SmartWeb

. EMEAEFERETRE

BENEEREFITAE

<7xml version="1.0" encoding="UTF-8"7=
<syn:LicenseDefinition xminsoesi="http:favon w3 org/200 12XMLSchema-instance™ xmins:syn="http://fis-services.da/synergia™
xsi:noMamespaceSchemal ocation="LicenseManagement. xsd™-
<=gyn:Licenses=
=syn:License>
<syn:Propertiss=

=syn:ld=A515FF31-B993-451D-A000-000000 000005 </syn-ld=

<syn:Mame=Channel Monitoring</syn:Name=

=syn:Scope>
=syn:SerialMumbersF4:30:80:00:1C:99</syn-SerialNumber-
<isyn:Scope=
yn:ValidUntil=2020-12-31T00:00:00Z </syn:ValidUnfil=
</syn:Properties=

<syn-Key=LBFVPJOKNXUCEhmCxn tedCsiQgtWep/uwRIDTR3GwDcQnd z o) dMMBuXxmSY GjglGdréRY WffdSFw\+i2 PR21drCpH2 kh 1HZemg Lzuzn
tDGmMV54n&g+gP+jAfKvQgralg0Qj2oMZlj6gUmzpw dglUkLJ2z AMIDIVP PriKmQLdAy9bddX GoY 4K2Cj8j3g KFhZWjggsmUUknUIX OxG+MZssATHpj
YovGEMsXaNidiGrZidkZ +Puw\WadpilPYIKDbHvxoBoQLAELThKssCRLWZJbri8J 2{2NdF 78 CzcOmS 0 GDbmiclsls abbkgr2aYkWaN Sh8Gvk DxCo3nx VT X
GZC==</syn:Key=
</syn:License=
<=syn:Licenses
=syn:Properties=
=syn:ld=A515FF31-B993-4510-A000-000000000007 </syn:ld=
<syn:Mame=Email</syn:Name:=
<syn:Scopes=
=syn:SerialNumber=F4:30:80:00:1C:99</syn-SerialNumber>
</syn:Scopes
yn:ValidUntil=2020-12-31T00:00:002 </syn:ValidUnfil=
<isyn:Properties=
<gynKey=0OMbt5CE 5z 5RadmVR03BaX0aYm1s/D5Fo/9t45Ke4F0gI0IFCnAMbulKWAONGK3ITq421 dkG5wRTH/8KpgabZRKPoe S GpY JgFzHsw2 +2

dNFVFLhjsqik3BKREmWC aTPkrTSQ0gF QO HWPwISsGEFEHKY QY +cNERapdMx0SgWDjuwiTqgZdDRyHnbDav3riSgUeny297i+r 1F GellkC- 0wl
OwSxVoBRVW\oRk2q3r3jNDeSXGIQFcA122iP3NIG pFvl3BbC 1KICIFsNdGaysApelMUrol7 FXe3Liws S5 E/GVOJZswlVmbou 1 HIOTI GCuZ GIMVC D+

SDUZEMoGSDA==</synKey=

%37 0 MERSFTEEN 8 MERGFTE. e
6. AUTER B0 . FEVF AT UE B E AR B 1S B R o A I B VR B VIR

I B AT A B VF AT AIE
FEVF AT IERE B 2% T s B R VF RTIE, R i B B © 0 LS i 5 A

22
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4 ¥ #%K Maintenance System

Schaeffler SmartCheck #£4 ProLink ###% Maintenance System $24t 4 [l RFRII6E . BlUn{d FH RS TFLR I 1, HeE
SmartCheck 224 ProLinki% % 844 KRB EH L& RS & . WA &EE — N EEREH K &. 4, Maintenance
System JEHARME ML KINGE, LMEHH Maintenance System =ik SmartCheck -4 ProLink ¥4 LA R
Do

Maintenance System {3 AT RRAS o M7 T U 4% 19 EL A [ AR, 450 2 22 31 42 B8 39 HR Al At o DI st y) W 48 T B

#T 7 SmartCheck E 4 ProlLink % Maintenance System )77 &
1. EHBERPERERERREET, FTAHMNED:

iR RRE

Schaeffler SmartWeb

2. EMNERFIER P ERIED S 3% % 1 Maintenance System.
3. AdE. 1P Maintenance System (¥ % T -

FLENDER DS500 38: -» Login Page

Maintenance System

R

“ersion: 1.0.22 (Build: 385834-20170320172011) Firmware 1.12.1 will start autematically in 2:57 minutes.

4. fiis Login 1 ¥4, 47JF Maintenance System K . #i@id Expert Menu s Pl B BN L R [ 26),
WHAE SmartCheck 4 ProLink B #0E T & H, M e Ml — 485 1E, 12l & 2l B 3 8
B . RSN BT E

16



# % ] Maintenance System

FLEMDER D5500 38: = Maintenance System

Maintenance System

@ Update firmware % Reset data parition Reset firmware

l— . ) Download debug log ah
—fy Adjust system settings 5 Open expert menu
- ustey g 8 files -y Openew
‘ Backup system t Restore system @ Reboot system
) | -
Version: 1.0.22 (Build: 385834-20170320173011) Firrnware 1.13.1 will start automatically in 2:57 minutes.

5. XFUbiE st — AN B, EFAER IR, MIhREIE, YIAPIT RSB A TR AR TR, 5
Maintenance System & IZhREH X HIFHE RIES A THIET .

) e 53 Maintenance System i}, SmartCheck %4 ProLink 5% W ot A il & !
‘2 « 4T7F Maintenance System [O3LIUTAENT, H[7E47 )75 Homepage #W 341, ki
#1, FKGR[EIZE Maintenance System B TR
e Maintenance System Fif5 —/MERZRThEE: WRKKERIELZ), WeHZER RS KAE
T B R T A AE Maintenance System HiAH 4G E
= Maintenance System (&30 2 405 E
= Maintenance System FIE HIFTAMIhAETL: 10 408l /5 E )5
= LRFEFEFT] Expert Menu: 60 /34
YRALEA N T o A % TR R ]

4.1 Update firmware: ¥ 37 [& 1
i Update firmware @ 28, JFRRZIThRE. AT TR AR AR AT B R G, O AN S B 0 2 A

PR RRASTE , AT P I D RER R A B 2 22— AN SE TH A A RRAS . FESXFEI IGO0 T~ B2
!i [EIN=¢Ve /8

B 05 SR A S DL T

e 1.10.0 i SmartCheck fiiAE# ProLink hitAs 1.18.0: W LAREZL 22 9 IH 1 p A

e 1.10.0 2 J51* SmartCheck iR A5 ProLink x4 1.18.0: HAERZ% 1.10.0 8¢ 1.18.0

B 3

1. fiih Select file MW 14 15 % BLAT s A6 SF2 SC1F.
2. HTIF SF2 SCf. BBUAMHTSCHE IR MR AT LUE R, AT LL, A e R 1

17
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FLEWMDER D5500 38: -» Update Firmware -> Select File

()
Update Firmware
Firmware file: i smartcheck-at91-1.12.2 20170502_164020-395886 512
The selected file contains the firmware 1.12.2 (Build: 20170502_164020-395886). I
LR URCTO URTOA0 T T O Al er 10 a00TT.
v X
Version: 1.0.22 (Build: 385834-20170320173011) Firrnware 1.13.1 will start automatically in 9:45 minutes.

BT SRR S R RSO T e A S
3. gk ok Y g, JEET R

-]

o TEREBTE MR & LT E MBS SEL, IERAREER . KHILTEEHimEd
SmartUtility #2F T 28 SR AL E, Mar—UI&0r. Bk S B B IE B I 2 4y
BEF B gl Fa ok

o THPITTRERREE S e, ZEIXBEI A M SmartCheck %4 ProLink 4 [/ LED ARZASHT A & & N
MR GO E, LT LSRR
o FEWrFF SmartCheck 4 ProLink %4 i HLE {45 .

o AEWIT SmartCheck 4 ProLink 14 LR MESE
o WHTEASEREH

WX L AT PR AL, B BERIEIER !

o WIRTEMRE TR HBL T — A EAE R, WSS E N 28 T IR S . 28 T i i [
WA S > BAME R

o WURCHHTREEE S, ETE S N %s Cache., Sy 1 g1 ) U 28k BT RRAS 1Y) Schaeffler
SmartWeb %, XIRALE.



# % ] Maintenance System

4.2 Reset data partition: = & 7 X

il Reset data partition % AL, PRI AE . T AR I EE B 4y X . DRI 2R R e AT I A, D
Fo B RFF AR

v ok % kl, EEAIE K.

4.3 Reset firmware: & i [# 14

s Reset firmware =), JF 2 0i0hfE. R AR HURS SUAEAER 70 X o PR B 28 e 10 P P 00 - P S A 2 Sl
I B E BN B E .

vt ok Y ek, SR

4.4 Adjust system settings: HE RZ X E
/il Adjust system settings == 40, 7IFE A %% 0 B o A0

FLENDER DS500 38: -» Adjust Systemn Settings

>»

Adjust System Settings

ﬂj Edit system name &;. Configure IPv4 settings
IPvd
@ Configure NTP server ﬁ;—é: Configure IPvG settings
|Fﬁ' Change administrator password Eé Replace server cerificate (PEM)

Version: 1.0.22 (Build: 39583£-20170320173011)

AT AL, FTOTHRIDIRE . 5 & hEEA RIVE SIS W SIS

4.4.1 Edit system name: % & & 4 & W&
A Edit system name o) e, FFRZBIEE. TTLLZEIL A SmartCheck 24 ProLink 4B — M &K .

WB ARG LR TN
1. ERIAHET A% SmartCheck 24 Prolink ¥4-Hi NFT 447K :

19
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FLEMDER D5500 38: = Adjust Systern Settings = Edit System Name

>»

Edit System Name

System name: FLENDER Dx500 36

Enter system name and click OK to save or Cancel to abort.

Version: 1.0.22 (Build: 385834-20170320173011)

2. it ok Y Bkl WA

4.4.2 Configure NTP server: it & NTP fik % %

fiii Configure NTP server © e, JFRZBhEE. W CAZE AR E — A NTP JIR%5#%, SmartCheck #4 ProLink ##%
AT LAMAZ AR 55 28 3R I R G (7]

BB NTP R % 2% 10 5 %
1. fERAMEFHN NTP RS2 IP ksl NTP AR 45 247k



# % ] Maintenance System

FLEWMDER D5500 38: = Adjust Systemn Settings -= Configure NTP Server

>»

Configure NTP Server

NTP server: ntp.rhri.uni-kl.de

Here you can configure an NTP server from which the system can load the
system time.

Enter the NTP server address and click OK to proceed or Cancel to abort.

v X

Version: 1.0.22 (Build: 385834-20170320173011)

2. ik OK Y AL, WA TP HEhEER NTP s 5 447K,

o WIRAEH] NTP fs5as4aF, W2t A\ DNS Hi 5543 8iiid DHCP i H &

g o UILHHE NTP MR45 28K E RG], M4 RWT#ATR%. F, SmartCheck %4 ProLink
U BRSNS, I H S BUGZ AT DL ) NTP IR458, A 1R %71

4.4.3 Change administrator password: & & & # R % 5
#iii Change administrator password CE@ b, TFR TR, e AT DL S R B R

BB R RS 5 =
1. 7 Administrator password HE $%i A\ J7 5 260 .
2. £ Reenter password Hz /4 N\ Y .

21
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FLEMDER D5500 38: = Adjust System Settings = Change Administrator Password

>»

Change Administrator Password
1. =———p Administrator password: (11T}
2, =P Reenter password: sene

Here you can change the administrator password.
Mote: Leaving the password empty will disable the user management.

Click OK to proceed or Cancel to abort.

Version: 1.0.22 (Build: 385834-20170320173011)

3. st oK Y 3L, .

) B RAE SR — AN B R, 2 AE SmartCheck 24 ProLink 4 1 [ hiil Al & .
= HSLARAE AN — M ER B 3R, W2/ SmartCheck 224 ProLink %4 48 HI I/ L.

4.4.4 Configure IPv4 settings: it & IPv4 % B
fiii Configure IPv4 settings WA, ERNZTAE . ATAEMLR IPV4 R4

4iiE IPv4 M 2% 3% B 17 R
1. . DHCP mode %R ik i fir 7 DHCP #i::



# % ] Maintenance System

FLEWMDER D5500 38: = Adjust System Settings -= Configure |Pvd Settings

>»

Configure IPv4 Settings

DHCP mode: DHCP: Load host name from ser «
Host name: FLENDERDX500

IP address: 192.168.1.100

Netmask: 255.255.255.0

Gateway:

Name server:

Select the DHCP mode and configure the network settings for IPv4.

Click OK to proceed or Cancel to abort.

v X

Version: 1.0.22 (Build: 385834-20170320173011)

1&A LA R
No DHCP

DHCP: Send host name to
server

DHCP: Load host name from
server

P ZE T A] LI g IPv4 Hidik, B 488461 SmartCheck %4 ProLink i%# )
2Rl IP Hhudik.

IR REAE S No DHCP, R4 thifEiZ LB aT e E, #ln IP
address, Netmask &l Gateway.

FIHiZ% 5 SmartCheck 4 ProLink ¥4 7] Hsh £ B M4 i 3RE IP k. &
HLAFRHE SmartCheck %4 ProLink &4 7E /2% f#) DNS AR %5#sd &4,

%I SmartCheck Z4 ProLink %4 7] H Bh7E LS KM 4% HR 3R AL IP Hohtk., @
I PIZ% ) DNS 45 88 4B EHLA FR

2. ¥ DHCP mode %%, i/t Host name. IP address. Netmask. Gateway 5 Name serveriii 5 & H:

EHE

3. i oK Y B, WHMERORR S R R E .

o WIEHRT % SmartCheck %4 ProLinkGeréts [ IP Hudil, TFE 2 Wi (bl T AN 7] Fij7 1)
H SmartWeb # . S48 J5 UAER B8 5 B 108 & Hotk, = H KA Maintenance

System.,

o WIRIELL DHCP Hah/ AL IP Huhit, WX A& A3h4r B IP Ml st L4 (DNS) Vi
i7] SmartCheck #4 ProLink % & . 25l IcikAE SN IP stk

4.4.5 Configure IPv6 settings: fic & IPv6 i B
/iili Configure IPV6 settings % i, FFR1iZuifie. wTEUL4i IPV6 % 1 .

e IPV6 I 45 % B 7 i

1. . DHCP mode %% ik 1 7 DHCP #ix:

23
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FLEMDER D5500 38: = Adjust Systemn Settings -= Configure |Pv3 Settings

(2)
Configure IPv6 Settings
DHCP mode: DHCP: Load host name from sert|
IP address: feg0::fe3d:80ff.fe00:1336
Netmask: 64
Gateway: 10.179.20.254
Name server:
Select the DHCP mode and configure the network settings for IPvE.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.22 (Build: 395834-20170320173011)
1847 LA I I
No DHCP FIF iz AT A e TPve Mk, B 4k4E{§i ] SmartCheck 4 ProLink 4%

B\ TP btk

WREH G No DHCP, 4t WIIEiZ LB PATHE#E, Fli IP
address, Netmask &l Gateway.

DHCP: Load host name from F|H %% SmartCheck B4 ProLink ¥4 1] [ h7E & I Z& TR 3R EL IP Hbdik. 38
server T4 ) DNS AR5 8 4 Fe EHLA FR o

2. % DHCP mode &#%i@, %Zi7IP address. Netmask. Gateway & Name serveriii T 15 & H e ## .
3. et OK Y gl WMEHORIEE B R4 0 B

o UIH % SmartCheck ZE4 ProLinkGerats fit IP Hudil, NIFE 2 BT B IE T AS BT 37 4]
ti SmartWeb # . SAJ5 UAUEN VA8 5 BT 0% & bk, FERH AR
o LnHiEL DHCP B3l IP sk, MM FTIEE HBh A EC IP Motk oli@ s EHLEHR (DNS) V5
i) SmartCheck B4 ProLink 4. 2 JE¥TCiAdi BN IP Hudik.

4.4.6 Replace server certificate (PEM): ¥ #: ik &% 2% iF

fiidi Replace server certificate (PEM) G e, JFEZmizhint. REAIETH TRIER - RS . TT LAt —
AN E CHIAR S 2+ % #e SmartCheck B4 ProLink 46 F{RE T RS BE+ .

B # SmartCheck Z 4 ProLink & & RS BIEHH G R

1. ik Server certificate file W i 482 FLAT FF 2 R 5 S4E B ¥y PEM SC1F.
2. 73T PEM 342 LB 7E Passphrase HEf#ii A PEM A4 HIAH < 2565 .



# % ] Maintenance System

FLEWMDER D35500 38: = Adjust Systemn Settings -= Replace Server Cerificate = Select File

>»

Replace Server Certificate

Server certificate file: i server2. pem
Passphrase: sene

Click OK to upload the server certificate or Cancel to abort.

v X

Version: 1.0.22 (Build: 385834-20170320173011) Firrnware 1.13.1 will start automatically in 9:53 minutes.

3. niilf OK v A, EARIEAS . RGE W SOAFIFAE T LA 22 RS A

FLEWDER 05500 38 = Adjust Systemn Settings -= Replace Server Certificate -= Install

>»

Replace Server Certificate

cert. wersion : 1 -~
=erial number : BE:CS5:63:FA:2B8:A3:52:8€
iz=zuer name : C=LDE, 3T=BY¥, L~3chweinfurt, C=3chasffler Technologiss GmbH & To. FG, OT=, -
CH=www. fag-smartcheck.com, emailAddress=industrial-services@schaeffler.com 3
=ubject name : T=LDE, 3T=BY, L=3chweinfurt, C=3chaeffler Technologies GmbH & To. K&, O0=—,
CH=www. fag-=smartcheck.com, emailAdddress=industrial-services@schaesffler.com
imsued on : 201E6-07-14 0B:-27:02

- SATE-AT-1% AE-%9-07 i

The server certificate is ready to be installed.

Click QK to install or Cancel to abort.

v X

‘ersion: 1.0.22 (Build: 395834-20170320173011} Firmware 1.13.1 will start automatically in 9:45 minutes.

RS PR A A R TR S 5 U 2 3 R e
4. piit oK Y bl 2SR .

4.5 Download debug log files: T ##f& H &

#iidi Download debug log files @ T, JFRZIhEE. AIER ORI MR H . AN RIEE A B %
. R IE BRI AR RS s, AT 24T

25



THE ST R

1. g oK Y . IFIE TR
2. WS T AR SR I 4 2 A R
3. WM RGREG . FAMIT. A5 TR F B Jerf4RE] *.SCLG Mb A

4.6 Open expert menu: 3T 77 & XK &4

/il Open expert menu &8 11, TF i %4 L 5005 RT.

FEL F R T 4% 2R i Schaeffler SmartCheck %24 ProLink #4436 A1 & (N RE. PAIX LB E 0 RGN 5 £ R E
2, FrolfOnE I A R ) K SRR T R 5O, SR EEREFARNEZE LIS T EY.

EXRBZEEREFOITAHET X
1 AEGFMEFRE T EA A ID. aTClEa Ak, WrrBUE rii % ID # R s AT BRI b

FLENDER D5500 38: -» Open Expert Menu = Login

»

Open Expert Menu - Access Verification

This section is password protected. Please call the customer support to generate
a one-time password from this ID:

—- Tab2a256

Click the button below to log into the restricted area. Enter the user and the
generated password for authentication. The password is valid until next system
reboot.

1

Version: 1.0.22 (Build: 385834-20170320173011)

2. BAMGEAR I F A% ID 4 — A — R S i I R A 1
3. &iif Login L1 124, FTIFIIETL, 7EUser Name HEH AN P 4, J-7E Password HEH ¥ A\ — K %15,

Authentication Required @
e A username and password are being requested by http://192.168.178.50.
The site says: "Web Server Authentication”
User Name:
Password:

[ o | [[conea |

4. pit oK Y Sl BB S

26



# % ] Maintenance System

FLEMDER D5500 38: = Open Expert Menu

>»

Open Expert Menu

m Reset administrator password D Start remote access semvice
—
& Replace cryptographic keys % Update Maintenance System

Clear entire system ® Reboot system

=\

Version: 1.0.22 (Build: 385834-20170320173011)

T AL STIFARIDIRE . 5% F AR T REA RIE BE S W o=

o [ 44bF Maintenance System i}, ID fl—REE A2k —HER SmartCheck E4
'i ProLink ##%, ID MIZHIEI%L%C. # 2 Maintenance System i, &6 — AN ID, 4RJE AT LA
M B AR SR O SR — N BT D
o MEEFRETIE A 60 A rf A, 20 H T EEHEARMRS F OB —R %, wREL

Wi O B Maintenance System JF A JLTIVcH A 2 5 SR B U, I e B2
WERIE 60 434,

4.6.1 Reset administrator password: &£ & & ¥ i & 15

#id7 Reset administrator password =8 14, FFRIZITINAE. FEI HLAT LUK EE B0 5T Ay 45 A8 A G AR
A, AR AT LA P B R S I A A EE SRR . ER M P A

it ok Y 3L, S (e B

f#/f] Change administrator password[ 29 Jjf¢, S H %%, @i Maintenance
'i System F3ZH ) Adjust system settings £ FIHH I BE .

4.6.2 Replace cryptographic keys: ¥ #& i % %5 7

#iii Replace cryptographic keys i Y, FFIRZIEhREE . N S e FH B3 B SO (*.SF2) A4 e
(*.SCBK) LAK Inas #4440 SCAH-F H & SCHE . W R Mg s mithde, WA ¥, B LH IR AN S TE RS L 28 B E

0 R O 5
1. it Keystore W i1 )42 FLAT hnas s i ity S0
2. TIPS

27
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FLEWMDER D5500 38: -= Open Expert Menu -= Replace Cryptographic Keys -= Select File

()
Replace Cryptographic Keys
Keystore: [@F smc-bkbin
Click OK to upload the cryptographic keys or Cancel to abort.
v X
Version: 1.0.22 (Build: 385834-20170320173011) Firrnware 1.13.1 will start automatically in 9:53 minutes.
3. A OK" A, EARINE R R . RGN SO AR W] LA SO R e d
FLEWMDER D5500 38 -= Open Expert Menu -> Replace Cryptographic Kays -= Install
()
Replace Cryptographic Keys
The cryptographic keys are ready to be installed.
Click OK to proceed or Cancel to abort.
v X
‘ersion: 1.0.22 (Build: 395834-20170320173011} Firmware 1.13.1 will start automatically in 9:45 minutes.

SRS PR S A A I A, A A A S
4. fiik oK Yk, sk .

4.6.3 Clear entire system: 58 4= il & & 4

fiidi Clear entire system ] T, TFRRZITIRe . TAEC N BR E G [ AF . TC B AN D e AR B R G
Maintenance System K EINHEEARZ R,



# % ] Maintenance System

1. piit ok Y 160, B RS RAWMG, I F I

FLEMDER D5500 38: = Open Expert Menu > Clear Entire Sytem

>»

Clear Entire System

The system has been cleared successfully. You need to install a
new firmware.

MNote: Please configure the IP address, otherwise the system will

be reset to the default IP address "192.168.1.100" after reboot.

Wersion: 1.0.20 (Build: 294980-20180815221038)

2. MIEDLAZE—AFE . MAh, BN AUEFEE SmartCheck Z4 ProLink %41 IP ik, F A3 Clidid thIjisfE
LB IP Huhik.

fffl T Clear entire system #:{EWi 5, SmartCheck %4 ProLink %% _F AN AEEEfa] [
!i fFo AEEH KA Z R, AR 07

o ifiid Update firmwarel 17 335 i) [ 14 S0 IR 28 9 4% o

o i Restore system[ 32 45—/ B @ &G O 5B RGINHRE XA L.

01 SR LS RO TN ThRg, 04 4 P VR R B0 3 & o AT HE (140,

4.6.4 Start remote access service: & it RAS J& 1 i& 2 15 1

Ji: Start remote access service = B, JFREEIEe. FATEA S FEF Lol FTP/Telnet ks 45 Bi% )
e N ML Maintenance System JSTEAE . E S SmartCheck 4 Prolink #42 )5, K458 Remote Access
Service (RAS, ZREVF RS

B RAS JF 8 & 12 15 1A B9 77 3K

1. pidi oK Y 41, it RAS JF R L )
2. RAS HIIRIENE, ARG MRS .

29
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FLEMDER D5500 38: = Open Expert Menu-> Start Remote Access Service

>»

Start Remote Access Service

Here you can start the remote access service (RAS). This function will enable
the support team to assist you via FTP/Telnet.
Click OK to proceed or Cancel to abort.

Version: 1.0.22 (Build: 385834-20170320173011)

4.6.5 Update Maintenance System: ¥ #i Maintenance System

fiii Update Maintenance System % B, TFRIZIUNAE. AAEM AL SML SCfF, HF Maintenance
System.

¥ 3 Maintenance System 175 &

1. fiidi Maintenance system file (e I8 R B e Maintenance System () SM1 S04,
2. FTHF SM1 3. RGOS s 19 Maintenance System [FIRAS :



# % ] Maintenance System

FLEMDER D5500 38: -» Update Maintenance System -= Select File

G
Update Maintenance System
Maintenance System file: (@ smc_rescue FLENDER_1.0.22 sm1
The selected file contains the Maintenance System 1.0.22 (Build: 20170502_164020-395886).
Click OK to upload the file or Cancel to abort.
v X
Version: 1.0.22 (Build: 385834-20170320173011) Firrnware 1.13.1 will start automatically in 2:50 minutes.

WR PG AN &4 Maintenance System, U4 3545 40 5038 41
3. miifi OK v ¥4, TE#H Maintenance System.

PAT ZTh R i TR B B 75 AL U742 % SmartCheck ZE 4 ProLink 4. W 7EH Frid 72
R IR A, DA RS e 2 A B IRA T BOR SCHF L

y

4.7 Backup system: &4 & 4;

A7 Backup system G e, JFaZIihaE. TR — N RS, SRR BB REE . s
Restore system|[ 32 DAL 5 IF A — NG IERIEE RS, SE Ehlds, LUERGIImEE LEE2
SmartCheck #£4 ProLink %% .

&R TT R
1. AEFEBIR A PRI G 146 (R

31



FLEMDER DSE500 38: = Badwp System

>»

Backup System

You can create a hackup copy of your system, for archiving purposes or for
safeguarding firmware, configurations and data.

Select a backup type and click OK to start the backup or Cancel to abort.

Firmware with configurations and data -
v X
Version: 1.0.22 (Build: 385834-20170320173011}
147 DL R 200
Firmware with I Z RIS G B A R G E . W EEE A&
configurations
(without data)
Firmware with IR AR G B

configurations and data
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% # 1, (Communication Data  —j
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BT FABEEHBRREFRE

HEi%E 5 Schaeffler SmartCheck %4 Prolink %% 3T 815 i F KT 3L
1. IT7F GX Works2# 1%,

2. #i: Project > Open.

3. ISR R IUE o

4. ESHIE O T g Parameter > PLC Parameter.

[ Parameter Setting

PLC Mame |PLC System |PLC File |PLCRAS |Boct File |Program |SFC | Device |10 assignment |Mulkiple CPU Setting  Builk-in Ethermet Port Setting |

—IP Address Setting

I Open Setting I
Input Format IDEC 'I
FTP Settitg |
P tiddrese [ 172]  z8] sl |
Time Setting |

Subnet Mask Pattermn | | | | |

Defauit Router IP Address: | | | | | | setfitis nesded( Defautt # Changed |

5. #£i%J-F Built-in Ethernet Port Setting + #.17 Open Setting.
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Built-in Ethernet Port Open Setting E

IP Address/Port Mo, Input Format  |DEC -

Pratacal Open Syatem TCP Connection HT:,S;[? :j'g.on II:)F'e;tldnd?ggg Dgztrltrﬁtfn
1 |UDF * |MELSOFT Connection = -
2 |TCP ¥ |MELSOFT Connection = -
3 |TCP ¥ |MELSOFT Connection = -
4 |TCP * [MELSOFT Connection = hd
5 |TCP ¥ |MELSOFT Connection  w A
6 |TCP ¥ |MELSOFT Connection  w hd
7 |TCP ¥ |MELSOFT Connection w hd
a |TCP ¥ |MELSOFT Connection = hd
9 |TCP » |MELSOFT Connection = hd
10 |TCF » |MELSOFT Connection = hd
11 |TCF * |MELSOFT Connection = -
12 |TCF ¥ |MELSOFT Connection = -
13 |TCF ¥ |MELSOFT Connection = -
14 |TCP * [MELSOFT Connection = hd
15 _|TCP > IMELSOFT Connection hd

|l 15 [TcP = [MCProtocol - - 1280 |

{*) IP Address and Port No. will be displayed by the selected format.
Flease enter the value according to the selected number.,

End Cancel |
6. PATTFHILE:
Protocol TCP
Open System MC Protocol
Host Station Port adtdl: 1280 (AHLF+75ikH: 05000
No.

7. i End il E
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— P Address Setting .
Open Setting |
Input Format IDEC 'I
FTF Setting |
P Asddress [ 172] 28] ewsfizz |
Time Setting |
Subnet Mask Pattern | [ [ [ |

Default Router IP Address | [ [ [ |

Setifitiz needed] Default /' Changed |

r— Communication D ata Code

' Binary Code

 ASCH Code

¥ Enable online change [FTP. MC Protocol)

[” Disable direct connection ko MELSOFT

[~ Do not respond o zearch for CPU [Built-in Ethemet port] on netwark

Print Window, .. | Print Window Preview | Acknowledge 2Y Assignment | Default | Check | End Cancel |

8. 7t Communication Data Code i % & {4153 Binary Code.

9. % Enable online change (FTP, MC Protocol), A ifin % Schaeffler SmartCheck Z4 ProLink % 5 A1l 45
e

10. #.i5 End.
11 K5 FEFF A 2 Task o
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E.r'_.: MELSOFT Series GX Works2 E:\_a\lm\_"m\!FAG_SLMP_Test\neuw.gxw - [Task Setting Task_01 ]

=10 x|

-8 X

! Project Edit Find/Replace  Compile  View Onlne Debug Disgnostics  Tool  Window  Help
NEAg e fixpRey REFSsRAs s ne A8 0 mw B
ErEIEE R e Y O EERET
i Navigation 1 x &1 POU [PRG] Program [S'IJ/Task Setting Task_01  * ] 4 F -
B ——— G =
1 _[POU
CF o B 2 B 1
[#- Parameter K] ]
Inteligent Function Module 4
Global Device Comment 5
EI@ Global Label B
-%E) Globall 7
£ Global_Vars g
=R E Frogram Setting 9
----- ﬂﬂ Initial Program 10
L—_I ﬂﬂ Scan Program 11
= MAIN 12
- Task_01 1
- {gd) PoU 14
ﬂﬂ Standby Program 15
-{ |} Fixed Scan Program 16
ﬂﬂ Mo Execution Type 17
H“"l POU 18
Eiﬂa Program 15
=-{gd) POU 20
o Program 7
‘i Local Label 2
g FB/FUN 73
I'_'I E Structured Data Types 24
@R SmartCheck_172_28_205 46 T 25
----- @i" Local Device Comment %
[+ Device Memory 27
Device Initial Value 28
29
m -
&L =S | ]
English Structured QO3UD Uz

12, il it e 3 B hik ¥ Compile > Rebuild AL ICHIET .

13 e i e 22 s &%

1E Schaeffler SmaltWeb TR A 4k S A A

SR 2:

1E Schaeffler SmartWeb # 4 ¥ fin 32 i 28

£ BAFEIE TR sl AT T %0 A 51 S AN D R 58 R 5 1

o £
o FEH BB RMEHISIUTEE:

— AP BRpERE RE Oy HAEE F E TE R 2



i &

HinEEEE

Schaeffler SmartWeb

TR F3: BC® Mitsubishi Controller (SLMP)

1 EEE e

2: ELH Mitsubishi Controller &} :| PLC_O12 o
[SLMP)

1P #dk 2 | 17228 205122

WmO:| 1280
| mEmE
Wi | Top -
R | Binary v

i3
£
fiit
o
i

Mitsubishi Controller g7
i EEEEITESMOLUE

TEEE EE =% Erkic
£ S PLC_018
IP Hb fik 172.28.205.122
¥ K k. 1280 CFH2 T+ N #k#|: 0500)
i TCP
e X e o]

SETTAE W50 /4 48 5 ) 8 oM 4 R BUOC T i A 201 25 1 B 245 L
HEREHIEUY, TR TER AR WUR U X R, B IR .

g

$ & 3. 7£ Schaeffler SmartWeb %k 44 o ¥ hn 2 #1 2% 59 %1 A\ I
7 BEEBENBAY: PLC_O18 i N4l N J-H £ SN & 0 b3 T LN HE:

113



114

# R
Y146 =5 17 4%
WA HRE
B fir B
LR
A7 E
E5HE

LA

Schaeffler SmartWeb

B FEESPLC_0BEEE
WHFFE: D000 7]
FFEE | WORD - 9
BEE: | s=EsE v Bir: rPMm v @
ERAB: | 1 ML)
5 RPM

B [RPM] : 200E3
163,837
B
16.35 100E3
4 [RPM] :
0.0

2E3 4E3 3| EE3 10E3

m
3

BT BAAE
10,000

i
hiil]
1

3% PLC_018

D1000

WORD

LR IELE

RPM

K Max [ %fE 2504 10000,

B35 Min KA 0 JFEXT Max i A% {E 3000.

SETTLE V5 0 / 4 48 5 1 8 10 N 3 1o 4 R 356 80 (TR I ) B A 0 T 220 L

CY

o WIHCE Schaeffler SmartWeb % rh G T N\, 07T 78 S i 8 7 (47 AL 75 e
Schaeffler SmartCheck %4 ProLink ¥ &8 4k

o b A\ TR P A A\ S A AR A 55 R AT A

$ 1% 4. 7 Schaeffler SmartWeb %k {4 o 1] 72 455 i) 5% 1) % B 3%
1 BEEENH L. PLC_O18 Wi K Adi 8l I H EHSmE —MEBh T T RE.:



AR

Schaeffler SmartWeb

&R

1: REFTEMEFRE

2 EEEHEET

Y146 & 17 4%
AT B4 R

S TR IS ER

TR

01200

REFHE:
D1208

FEEE

80 %

RS

AR HRRS
< EEHE
— 4 BERWHS [v

— & Base measurement job :J

& FoanA
Qam-7=
® RMS E=1 AF—HR)

& RMS3 E=1 F— 432} |
@& 13010816-1 (2Hz - 1kHz) - EE :J
@ C—F b e—C— s E (R [v

i
1

D1200
A AR S TR A A i 2 4 i i O A

RWRE

i &

®

BEX 3 A I B A 55 R MEAE R AR EDIRAS R AT X ISO 10816-1 P LR ERES M

Hff . IR TR R /ME

L) G055 25 AT AR 00 BERAS 2 1 Bh TR () 25 77 8% 48 PR . JETT(E 9% 0 / 40 8 92 o) 58 10 B o o (109N 349 o 3106 T
O LA Fas o] 3 S PO T L 245

S5 KR b iR B X RFE Schaeffler SmartWeb #i £

1. 76 BAEEE Kt < TR b S s A

2. fTITRCE AT
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@ Mozilla Firefox == EeR

| Suche oder Adresse eingeben |

(*SOFTCONTROL @
VERSICN:7.04.01%)
TYEE
SmartCheck 172 28 205 234 T:
STRUCT
config version: INT:=5;
kommunikationsstatus: INT:=0;
a geratestatus: INT:=0;
a is0l0816_1 10hz 1khz geschwin: INT:=0;
k 15010816 1 10hz 1khz geschwin: REAL:=0.0;
END STRUCT;
END TYPE
VAR GLOBAL
SmartCheck 172 28 205 234 AT @'sMWO0.1200,3%MW0.1201,%MW0.1202,3MW0.1203, 3MD0.1204":
SmartCheck 172 28 205_234 T:
END VAR

PROGRAM POU
(=)
(=)
VAR EXTERNAL
SmartCheck 172 28 205 234: SmartCheck 172 28 205 234 T;
END VAR
ISTI
BODY
MOVE( S5M402, 5, SmartCheck 172 28 205_234.config version )
END BODY
END PROGRAM

CONFIGURATICHN scConfiguration
EESCOURCE scResource CHN scResocurceType
VAR GLOBAL
END VAR
END RESOURCE
END CONFIGURATION

x

3. @it CTRL+A #%EHE AL, @i CTRL+C I G 6| 2 350k st CTRL+V IR mME — M iEsd (Fla
Microsoft Editor) .

4. M E%N JASC R AR (Blan:  SmartCheck #4 Prolinko1.asc) .

_ o WIRMEZ Mozilla Firefox Wiy, WIF B HEL 5 77 A RS 53479 ASCIL SCAF.
& o THME MRS JASC, IXFEA RERL GX Works2 BAFEHR .

H# I 6: LA GX Works2 1 i g B X 14

£S5 A\ Schaeffler SmartCheck 4 Prolink it B S0 /F 2 Biis e &M A I E .

g

1. % Project > Open Other Data > Read ASC Format File.
2. S lE R ASCII Sk (LASC) L diHi 5E -

3. A Schaeffler SmartCheck 4 ProLink FCE ST, JF HAEM 1 AENH Global Label, #5kM
Global_Vars .
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[EE MELSOFT Series GX WorksZ ...bi

iSonst DemosteverungFAGYFAG'\FAG_DEMO_Rack - [Global Label Setting Global_¥ars ]

i Project Edit  FindiReplace  Compile  Yiew Online  Debug  Diagnostics  Tool  Window  Help =0
PP B i 5E B T ey e | B B G| 5 R R SR |l LR e 6
DRk eh s X EE e e ]
i Navigation ax £ Local Label Setting POU_A1 [PRG] rﬁpou_m [PRE] Frogram [Structured./ &Lﬁlohal Label Setting Global... ] 40 -
L,y m Class Label MHame el e Coratant Devion ﬂ
; 1 |wAR_GLOBAL = |SmartCheck_172_26 205_46 |SmanCheck_172_25_205_46 T D etail 5 etting Detail 5
[P 2y (2 Gs 2| M z =
{3 Parameter 3 -
[} Inteligent Function Madule 4 -
Jl_} Global Device Camment 5 =
= Global Label g -
% Globall 7 -
% Global_Vars 3 =
[#-fizg Program Setting q =
B4 ol 10 -
.'_j Program 1 =
=4 POU_D1 12 -
4§ Program 13 -
: @ Local Label 14 =
{8 PoU 15 -
j FE/FLN 15 -
B Struckured Data Types 17 -
Local Device Comment 18 -
[+ Device Memary 19 -
----- Device Initial Yalue 20 =
A hd
......... o -
Jﬁ Project 23 hd
24 hd -
L_.)I User Library o | >|
= Systemn Label Operation *Tq reflect the cha
Connection Destinaktion f
!i Change O Register Release system label databa
OEME Motification M | qj Device Mame Relation please save the pro
»
=« | |
Structured QOEUDEH Host Station Line 1 Cal. & L

7E#: Device H .7 Detail Setting i, # EoRkiEE 5 C 175

SmartCheck_172_28_205_46
{Smartcheck_172_28_205_46_T)

Label Hame Data Type Device Address 1=
conlig_wersion W ord[Signed] R Zhw2.98
device_status Word[Signed] R100 bW 2100
standardmeszaufgabe Word[Signed] R101 kw2101
io] 0816_1_10hz_Tkhz_gf'\Word[Signed] R102 EMwiz 102
communication_status Word[Signed] R399 Zhw2.99

4

]

v Automatic Filling

¥ Use Bit Designation

[ o ]

Cancel |

BB, T ICwET R E TS

1. BEfeE Rt kP Compile > Rebuild AILUEICTRT .

2. & R R AR A A

8.7.2.5.2 =ZF % GX IEC Developer

SEL ABREHSTRNEGRE

ek B Schaeffler SmartCheck 4 ProlLink %4347 815 T 75 1 TG 23

1. #77F GX IEC Developerifff.
#.17 Project > Open.

I R¥ Schaeffler SmartCheck 4 ProLink it & S AN H A HIRH «

2
3.
4. 7E 5% O b X Parameter > PLC Parameter.
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Q parameter setting

FLC narne |PLE zyzteni |PLE file |F'LI: RAS |Device |F'rc:gram |Boot file |SFE |I£D azzignment  Builtin Ethernet part

—IP address

|rpit Fiarmat I DEC j'

IP addrezs |

172 2g]

205]

127]

Subnet mask pattem [

Default router IP address |

5. fEi&Ti-F Built-in Ethernet port 11 #.i; Open settings.

FTP zettings

I Open settings I

Time seftings

Setifitis needed] Default / Changed |

IP Address/Port No. Input Format  |DEC e
Protocol Open System TCP Connection H‘::rfﬁ:on ?:it; darzg: D;zf?;g?n
1 |UDP ¥ |MELSOFT Connection hd hd
2 |TCP ¥ |MELSOFT Connection hd hd
3 |TCP ¥ |MELSOFT Connection - -
4 |TCP ¥ |MELSOFT Connection - -
5 |TCP ¥ |MELSOFT Connection v v
6 |TCP ¥ |MELSOFT Connection i i
7 |TCP ¥ |MELSOFT Connection b b
a |TCP ¥ |MELSOFT Connection hd hd
g |TCP ¥ |MELSOFT Connection hd hd
10 (TCP ¥ |MELSOFT Connection - -
11 [TCP ¥ |MELSOFT Connection - -
12 [TCP ¥ |MELSOFT Connection - -
13 |TCP ¥ |MELSOFT Connection i i
14 |TCP ¥ |MELSOFT Connection i i
15 (TCP LIMFI SOFT Connection b -
I 16 |TCP v [MCProtocol - - 1280(]
(*) IP Address and Port Mo, will be displayed by the selected format.
Flease enter the value according to the selected number,
End I Cancel

6. AT TFIIBE:

Protocol TCP
Open System MC Protocol
Host Station Port k. 1280

No.
7. rmiifi End BARE.




Q) parameter setting

FLC name IF'LC zpghem IF'LC file |F'LE RAS IDevice IProgram |Eoot file ISFC II.:’D azzignment  Built-in Ethernet port

—IP address

Open zettings |

|nput farmat I DEC

[~

FTF zettings

IP addrezs |

172 2g]

205]

122]

Subret mazk patterm [

Time settings |

Default router IP address |

Setif it is needed| Default / Changed |

r— Communication data code—

' Binary code

™ ASCI code

¥ Enable anline change [FTP, MC protacal)

[" Disable direct connection to MELSOFT

[ Do nat respond to search for CPU [Buill-in Ethernet port] on network

.&cknowledgeWassignmentl Fultiple CPL settingsl Default | Check |

End | Cancel |

8. 7£ Communication Data Code 7 | % & L4t Binary Code.

9. % Enable online change (FTP, MC Protocol), AT A 7E4% i #% 1 5 A Schaeffler SmartCheck Z£-4 ProLink %4
o

10. #.i5 End.
11 KR EAS Task .

ESmartCh eck_IEC - GX IEC Developer - [MAIN_LD (Prio = 31, Event = TRUE}]

- Ol x|
IE Project Object Edit Tools Onlne Debug View Extras Window Help ;lilll‘
zE SR & i -« 20| crnm |6 oo o||FE| FE|
SmartChack IEC =)= POU name Comment =
Project [c\FAG\SmartCheck_IEC] 0jPoOU_01

Ifﬂ Library_Pool
Parameter

- PLC

- Netwark

Bl Module Configuration
=0 Task_Pool

i {Ty [MAIN_LD (Prio = 31, Event = TRUE)]

=85 DUT_Pool
w33 smart_Check_172_28_205_46_T

..... L@ Global_vars

EI% POU_Pool

E---D[; POU_D1 [PRE]

& Project |a@, caltree | @2 Used by |

Ready

| €Ty 17:37 [TASKMAIN_LD: Event TRUE, In [Q20UDEH

12. @it e b i Compile > Rebuild ANLLEIC 2L fF .

13. KR P AR 2 P 1 s o

1£ Schaeffler SmartWeb {4 H 4k 40 B 7% 41 2% .

i &
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$ & 2. 7& Schaeffler SmartWeb % {4 o 75 hn % 1) 2%

fE IBARIBIE R A B NFTITIR S . 20 SR 5] S8 P A0 BR 58 i B A 5 d T -

o FEGE D BRI FR A H A 0 (I A F A 4

o~

o FEHTAPERPRAIEHESIUTE R

TEEE
ey S PLC_018
IP Hhidik

¥ 1

17328 TCP
iR = 3kl

ST AE 50/ 95 58 4 1) 38 (oM 40w B 5 B e A 42 1 2% 1 B 24 L

FEinEFEE

Schaeffler SmartWeb

&3

1 EREEEERT

2: EL® Mitsubishi Controller
{S5LMP)

Mitsubishi Confroller &7

s

ERARSBETNROLUR

#5%: BLH Mitsubishi Controller {SLMP)

HI:| PLC_018

1P #dk 2 | 17228 205122

W|O:| 1280
| =EEE
Wil :| TCP
HHWRIN ;| Binary
BRI
BE

172.28.205.122

). 1280 AT+ 7Nt 0500)

it

=8

HER AR U, PR ERE RN B RS DO R Y, R BT IR .

g

$ 1% 3: 7 Schaeffler SmartWeb k4 o 75 i 4% 1 8% 1 %0 A\ 5%

£ B EER R A : PLC_018 Ji T i i JFH /& I A & 1P ibAT DU 8



i &

LA

Schaeffler SmartWeb

£/ | FSPLC_0M18E9EE

WHFFE: D000 7]
FEEER: | WORD - @
BEE: | S=sa v Bir: rPMm v @
ARAH: | 15 - @
F5E: RPM
BK [RPM] : 200E2
163,837 oo
By
16.38 100E3
B [RPM) : -
0.0 SLEs
2E3 4E3 6E3 EE3 10EZ
B BOCAE
2] 0.0 10,000
2 i# PLC_018
VI &5 7 2 D1000
FEBER WORD
B ¥ AR [
FAL RPM
FFE ¥ Max F%(EZSCH 10000,
51 ExE Min FANEE 0 JF4F% Max A %{E 3000.

TROTTE T30/ 9 48 425 1) 8% 0 O\ 3 ol = bl 38 o 1 L i VA 42 o) B N O T 22435 5
o IR CTE Schaeffler SmartWeb #fF g T % A, A 76 2t B 7 (4 k2 75 i

=1 Schaeffler SmartCheck 4. ProLink % % B8 .
o IMbAan N ity T AT PN B A N it — REAE DN BAT 55 R kAT A

$ 1% 4. 7 Schaeffler SmartWeb %k {4 o 1] 72 455 i) 5% 1) % B 3%
1 BEEENH L. PLC_O18 Wi K Adi 8l I H EHSmE —MEBh T T RE.:
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AR

Schaeffler SmartWeb

&R

1: REFTEMEFRE

2 EEEHEET

Y146 & 17 4%
AT B4 R

S TR IS ER

TR

01200

REFHE:
D1208

FEEE

80 %

RS

AR HRRS
< EEHE
— 4 BERWHS [v

— & Base measurement job :J

& FoanA
Qam-7=
® RMS E=1 AF—HR)

& RMS3 E=1 F— 432} |
@& 13010816-1 (2Hz - 1kHz) - EE :J
@ C—F b e—C— s E (R [v

i
1

D1200
A AR S TR A A i 2 4 i i O A

RWRE

®

BEX 3 A I B A 55 R MEAE R AR EDIRAS R AT X ISO 10816-1 P LR ERES M

Hff . IR TR R /ME

L) G055 25 AT AR 00 BERAS 2 1 Bh TR () 25 77 8% 48 PR . JETT(E 9% 0 / 40 8 92 o) 58 10 B o o (109N 349 o 3106 T
O LA Fas o] 3 S PO T L 245

S5 KR b iR B X RFE Schaeffler SmartWeb #i £

1. 76 BAEEE Kt < TR b S s A

2. fTITRCE AT



i &

@ Mozilla Firefox == EeR

| Suche oder Adresse eingeben

(*SOFTCONTROL @
VERSICN:7.04.01%)
TYEE
SmartCheck 172 28 205 234 T:
STRUCT
config version: INT:=5;
kommunikationsstatus: INT:=0;
a geratestatus: INT:=0;
a is0l0816_1 10hz 1khz geschwin: INT:=0;
k 15010816 1 10hz 1khz geschwin: REAL:=0.0;
END STRUCT;
END TYPE
VAR GLOBAL
SmartCheck 172 28 205 234 AT @'sMWO0.1200,3%MW0.1201,%MW0.1202,3MW0.1203, 3MD0.1204":
SmartCheck 172 28 205_234 T:
END VAR

PROGRAM POU
(=)
(=)
VAR EXTERNAL
SmartCheck 172 28 205 234: SmartCheck 172 28 205 234 T;
END VAR
ISTI
BODY
MOVE( S5M402, 5, SmartCheck 172 28 205_234.config version )
END BODY
END PROGRAM

CONFIGURATICHN scConfiguration
EESCOURCE scResource CHN scResocurceType
VAR GLOBAL
END VAR
END RESOURCE
END CONFIGURATION

x

3. JHif CTRL+A JEFE N, #id CTRL+C KR H| 2GR Filid CTRL+V BN & — Mt (i

Microsoft Editor) .
4. M E%N JASC R AR (Blan:  SmartCheck #4 Prolinko1.asc) .

_ o WIRMEZ Mozilla Firefox Wiy, WIF B HEL 5 77 A RS 53479 ASCIL SCAF.
& o THME MRS JASC, IXFEA RERL GX Works2 BAFEHR .

H# I 6: LA GX Works2 1 i g B X 14

£S5 A\ Schaeffler SmartCheck 4 Prolink it B S0 /F 2 Biis e &M A I E .

g

1. % Project > Open Other Data > Read ASC Format File.
2. S lE R ASCII Sk (LASC) L diHi 5E -

3. A Schaeffler SmartCheck 4 ProLink FCE ST, JF HAEM 1 AENH Global Label, #5kM
Global_Vars .
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EHsmartCheck_IEC - GX IEC Developer - [Global Variable List]

iy =] 3]
Iﬁ Project Object Edit Tools Online Debug View Extras Window Help =] =l
EEIEEEE IR I E | E 1L
SmartCheck FC————alx| Class Identifier MIT-Addr. IEC-Addr. Type =
Project [c:\FAG \SmartCheck_IEC] 4+ 0VAR_GLOBAL ~[Smart_Check_172_28_205_46 |lconfig_version: R98 |jconfig_version: %MW2 |Smart_Check_172_26_205|
I Lff‘ Library_Pool

...l Module Configuration
-4y Task_pool
...y MAIN_LD (Prio = 31, Event = TRUE)
E-§§ DUT_Pool
-89 smart_Check_172_28_205_46_T
-Ig Global_Vars
=-ag POU_Pool
-8 POU_D1 [PRE]

@ Project |°|*_—‘> Caltree | 92 Used byl | | =

[
[T 17:34 [GVL: 1 Dedarations |qzouDEn G
7EF: Device il Detail Setting I, # S R4 5K AR
x
Smart_Check_172_28_205_4F [Smart_Check_172_28_205_4E_T)
Name Type | M1 T -l | IEC-Addr. -]
1 |config_version WORD R9e bW 2 98
2 |device_status WORD R100 Zhiw/2100
3 |standardmeszaufgabe WORD R101 M2 101
4 |isc10816_1_10hz_1khz_g |WORD Ri102 w2102
5 |comunication_status WORD R399 Zhiw/299
. |L|ﬂ
¥ Autamatic filling ¥ &l Types Expart Irnpart | oK I Cancel |
*/FE% 7: CHRFEF I AL B A
Wt E S b ik $:Compile > Rebuild ANULEIC 4 F2 /5 .
2. B UFE R IR HAR R R S
8.7.3H T OPCUA Ik % %% i i 15 @ &
OPC UA #&—NFH LA S I 4% 11380 125 A B A2 et bt . /038 {5838 (OPC UA FR%-28) [ AXsp, EaricE
Schaeffler SmartCheck %24 ProLink % #%{F% OPC UA JIrR%5#5. 285, AT DL A4 i) 23 BOZ R & B RFAEME . Bk4t,
TEaE w] o At Az ) 28 10 1 F2 2408 OPC UA JIRSS 23 K% A\ i % 5 21 SmartCheck ZE4 ProLink &, JyT AeR FH LT
FETNRE, THEMAT NP RR:
o JEWZE SN OPC UA IR 234t Al imia 2, ﬁtﬁﬂﬁz&ﬁmﬁ&%éﬁm%ﬂ OLSAN g/
o ML OPC UA M55 2% MILAhhl 835 N B0, AU ILTR I — ek A OPC UA JIi4s 28 i Aot [ 2, &oxt
TR R N S 6 U T8 DA 1) 4 ) B A7 2 @E@ﬁ)ﬁﬁﬁﬁiﬁuﬁﬂiﬂﬁﬂlﬁuﬁ WL AL TE A A7 28 R 45 T8RS B R
145 5 AL B REE SETE

o &y OPC UA R4 43 TR INAT i 2 AN NS, I FLAE SmartWeb B b FX £ediy Ao, 55 16 7 A i i 2 [ 520X 35k
IR —HF; JTIHRE ST %E%l_ﬁ iae SEIEE b iﬁiﬁ%ﬁl_fﬁﬁaéﬂ’]E&%%%iﬁu)\iﬁ'ﬁ"ﬂﬁ‘”ﬁﬁﬁo

o fEF]—/> OPC UA %/ 3l TAR Al OPC UA i 55 45% nl i MR Le it . S mT It AL OPC UA iz 55-4% T 3T i A% 2K
e
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i &

8.7.3.1 1 T OPC UA ik 55 #% i) i {5 3@ iE [X 1%

TEE 15 38 18 DXk b ] 78 JE T 1) A0 L S vh #2145 Schaeffler SmartCheck %24 ProLink #4474y OPC UA fIR%5#5. 7
A R TAEX AT 2156 T OPC UA 5548 IBEACTERS, W R CAsn 1 M\, 8w #RE5¢ T HAm A\ i 145 B«

Schaeffler SmartWeb - f:"?* ¢ SmartCheck 38 ®
SEE 5 admin
Tt w gE v JEEEV ERw i v
[ EEEE (=]
£ OPCUARSE TR 2019-12-18 20:15:42
T &3 : 2019-12-18 20:15:42
EZLA : admin
orc OPG LA server s a= - EE tE
2oPLC D18
BFA—u BISEMEAMA : OPC UA server
+ [ &&
@ == =k BAMET BRES L2 BAFFE BASTE R
w] EEMIER Speed input -10.0 10.0 [kHz] -10.0 10.0 1.0
F EE - #iEs + F

it OPC UA JEZ5%, BITT 6 e TR X sy 1 LA T 43 LRI D A
@M
EUETTHRF T OPC UA R4 33 f 3 A (35 BRI Ty
o TTYEAR BR S5 A M AL 4 B T FTT A AR 25 52 0 1
o W CUMTE OPC UA JIRZS SU0TE, 7 Mo Abil iy 4R 51 F2 42 A1 7S H AR 615 .
o MbdRIN T, EVRIVRAN A OPC UA 4558, AI7EVR N/ %% OPC UA IR 45 58 [V F 4k BIHI 6 P40t
.
o Ml S, W4 OPC UA %58, (5T 7EVR N/ 4i %% OPC UA R 25 58 2Pl R4k SIAI 6 HELn il
o VXTI OPC UA R4 S8 S imiti. bl S —, SRS b & ST A
o 547 o7 B T T B - ke,
SR B BLAGE PN
FEIX BLTTHR B E 04 OPC UA RS S8R IS NS — Y22 o 1 7E AL T $A5 L £ S A6 3
o BMAGHINMIBINEE, BT EKR2A, EOEENELERIIMAMEEEEE ESRMEES
B , BT (HaRER M T FFRERKME) DU A 1.
o SiligRiE £ RITTGAR . (STIZEVR I /%58 OPC UA IR 25 52 i i N\ 3 728V F 4k SUAH S5 VR4
o AUEVRIN T EIRIRINT ZH . EATETRIN /405 OPC UA R 2552 i B\ o [2PU R 4R SUA 6 V4
Wi,
o ETTLAMERFTE TS AT T, SRS AR A
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EICEMER O B WRAT 5563 dh i A bt ECREROTE B0 IR — SRB gk . 452
g BR RS A A\ S, 6 285G B L AE S P O AT 55

8.7.3.2 i In/4mE OPC UA Ik 55 23
Ak Schaeffler SmartCheck ZE4 ProLink ¥ #% F{E OPC UA 4525, #X0AZ0 IR B8 (5 8 IE .

@l OPC UA Jk 55 25 i) 38 15 8 18

1. (EBEEE T AFmm TR S . %0 S K5 S0 TR e R O i {3 S i
2. fEHMPRPEFHEFEEHRT OPC UA k5% .

3. SR EEIENE T ANPIR. fERAE AR A % OPC UA IR 55 &3 1T 5 U -

o

RREEEE

Schaeffler SmartWeb

&3 5% ¥ OPC UA RS

1 EREEEERE

2: iE® OPC UA BHE BEE®EO: | 4340 9
BEHE

ik
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Schaeffler Monitoring Services GmbH
KaiserstraBe 100

52134 Herzogenrath
T

Hif: +49 2407 9149-66
fEH.: +49 2407 9149-59
HARIFE: +49 2407 9149-99

M. www.schaeffler.com/services
F£ {5 H: www.schaeffler.de/en/condition-monitoring/smartcheck
Bt & 7R industrial-services@schaeffler.com
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Schaeffler Technologies AG & Co. KG
MR (E 46 1260

97419 Schweinfurt
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Georg-Schéfer-StraBe 30
97421 Schweinfurt
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F1g: +49 2407 9149 99
HT-HEFE: support.is@schaeffler.com

KT &% Schaeffler SmartCheck 24 ProLink FHAHRIFIE A= i, FA T AEIREFIAR SR . RT3 I7 R MR S5 77 =
Y R VEAN VLR, 5 V5 el PhE www.schaeffler.de/en/condition-monitoring/smartcheck.

141


http://www.schaeffler.com/services
http://www.schaeffler.de/en/condition-monitoring/smartcheck
mailto:industrial-services@schaeffler.com
mailto:support.is@schaeffler.com
http://www.schaeffler.de/en/condition-monitoring/smartcheck

	常规
	关于本手册

	启动软件
	用户界面总览
	更新固件
	选择重启设备
	添加许可证或者许可证组

	设备的 Maintenance System
	Update firmware: 更新固件
	Reset data partition: 重置数据分区
	Reset firmware: 复位固件
	Adjust system settings: 调整系统设置
	Edit system name: 编辑系统名称
	Configure NTP server: 配置 NTP 服务器
	Change administrator password: 修改管理员密码
	Configure IPv4 settings: 配置 IPv4 设置
	Configure IPv6 settings: 配置 IPv6 设置
	Replace server certificate (PEM): 更换服务器证书

	Download debug log files: 下载故障日志文件
	Open expert menu: 打开专家菜单
	Reset administrator password: 重置管理员密码
	Replace cryptographic keys: 更换加密密钥
	Clear entire system: 完全删除系统
	Start remote access service: 通过 RAS 启动远程访问
	Update Maintenance System: 更新 Maintenance System

	Backup system: 备份系统
	Restore system: 修复系统
	Reboot system: 重启系统

	状态
	在日志中创建 / 编辑状态信息

	测量数据
	编辑报警设置
	下载测量数据
	删除测量数据

	实时显示
	配置
	模块配置（仅 ProLink）
	输入端配置
	内部传感器（仅 SmartCheck）
	模拟输入端
	数字输入端
	带固定数值的输入端

	测量任务
	测量任务功能区
	创建 / 编辑新的测量任务
	可用的测量配置模板
	测量触发器和测量条件
	时间触发器
	测量触发器
	时间条件
	测量条件

	学习模式和报警特性曲线

	输出端配置
	添加 / 编辑输出端配置
	测试输出端配置

	测量触发器
	添加 / 编辑测量触发器

	测量条件
	添加 / 编辑测量条件

	通信通道
	用于电子邮件的通信通道
	用于电子邮件的通信通道区域
	添加/编辑电子邮件通信通道
	添加/编辑电子邮件通信通道的输出
	连接测试时的错误消息

	用于控制器的通信通道
	控制器的通信通道区域
	添加/编辑控制器
	添加/编辑控制器的输入端
	添加/编辑控制器的输出端
	将控制器整合到系统中
	三菱软件 GX Works2
	三菱软件 GX IEC Developer


	用于 OPC UA 服务器的通信通道
	用于 OPC UA 服务器的通信通道区域
	添加/编辑 OPC UA 服务器
	添加/编辑 OPC UA 服务器的输入端


	设备
	设备设置
	系统时间设置

	轴承
	添加 / 编辑轴承

	轴承制造商

	用户管理
	添加 / 编辑用户组
	添加 / 编辑用户

	制造商/技术支持

